LICENSE NOTICE TO PURCHASER

Bio-Rad Real-time thermal cycler CFX96 or CFX384 is licensed real-time thermal cycler(s) under Applera’s United States Patent No. 6,814,934 B1 for use in research and for all other fields except the field of veterinary diagnostics.

Bio-Rad Real-time thermal cycler CFX96 or CFX384 is covered by one or more of the following U.S. patents, their foreign counterparts, or their foreign patents pending, owned by Eppendorf AG: US Patent Nos. 6,767,512 and 7,074,367. No rights are conveyed expressly, by implication or estoppel to any patents on PCR methods, or to any patent claiming a reagent or kit.

Bio-Rad’s Hard-Shell plates are covered by one or more of the following U.S. patents, patents pending, or their foreign counterparts, owned by Eppendorf AG: US Patent Nos. 7,347,977, 6,340,589, 6,528,302 and US application 2007246858, 20080084004, 20030180192 and 20060120927

Bio-Rad laboratories, Inc. is licensed by Biotium Inc. to sell reagents containing EvaGreen dye for use in real-time PCR, for research purposes only.

SYBR Green is a registered trademark of Molecular Probes, Inc. EvaGreen is a registered trademark of Biotium, Inc.
**Bio-Rad Resources**

Bio-Rad provides many resources for scientists, including rich technical resources on a wide variety of methods and applications related to PCR, real-time PCR, gene expression and HRM analysis. Table 1 lists Bio-Rad resources.

**Table 1. Bio-Rad resources**

<table>
<thead>
<tr>
<th>Resource</th>
<th>How to Contact</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Bio-Rad Laboratories</td>
<td>Find local information and contacts on the Bio-Rad website by selecting your country on the home page (<a href="http://www.bio-rad.com">www.bio-rad.com</a>). Find the nearest international office listed on the back of this manual</td>
</tr>
<tr>
<td>representatives</td>
<td></td>
</tr>
<tr>
<td>Technical notes and literature</td>
<td>Go to the Bio-Rad website (<a href="http://www.bio-rad.com">www.bio-rad.com</a>) or Gene Expression Gateway (<a href="http://www.bio-rad.com/genomics/">www.bio-rad.com/genomics/</a>). Type a search term in the Search box and select Literature to find links to technical notes, manuals, and other literature</td>
</tr>
<tr>
<td>Technical specialists</td>
<td>Bio-Rad’s Technical Support department is staffed with experienced scientists to provide customers with practical and expert solutions. To find local technical support on the phone, contact your nearest Bio-Rad office. For technical support in the United States and Canada, call 1-800-424-6723 (toll-free phone), and select the technical support option</td>
</tr>
</tbody>
</table>

**Writing Conventions Used in this Manual**

The manual uses the writing conventions listed in Table 2.

**Table 2. Conventions used in this manual**

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIP:</td>
<td>Provides helpful information and instructions, including information explained in further detail elsewhere in this manual</td>
</tr>
<tr>
<td>NOTE:</td>
<td>Provides important information, including information explained in further detail elsewhere in this manual</td>
</tr>
<tr>
<td>WARNING!</td>
<td>Explains very important information about something that might cause data loss</td>
</tr>
<tr>
<td>X &gt; Y</td>
<td>Select X and then select Y from a toolbar, menu or software window</td>
</tr>
</tbody>
</table>
# Table of Contents

- Bio-Rad Resources ................................................................. ii  
- Writing Conventions Used in this Manual .............................. ii  

## Chapter 1. HRM Analysis ................................................... 1  
  - Introduction to HRM Analysis ............................................ 1  
  - Guidelines for Successful HRM Analysis ............................ 2  
  - Dye Compatibility .......................................................... 3  
  - HRM Analysis in the Literature ........................................ 3  
  - References ........................................................................ 4  

## Chapter 2. Precision Melt Analysis™ Software ..................... 5  
  - Instrument Compatibility .................................................. 5  
  - Precision Melt Analysis Software Components .................. 5  
  - Software Installation ..................................................... 6  
  - Hardware Protection Key ................................................ 8  
  - Melt Calibration ................................................................ 8  

## Chapter 3. Introduction to Precision Melt Analysis Software .... 13  
  - Main Software Window .................................................... 13  
  - Startup Wizard .............................................................. 16  
  - Analysis Options Manager .............................................. 16  
  - Software Files .................................................................. 18  
  - Software Help Tools ....................................................... 19  
  - Tips and Tricks .................................................................. 19  

## Chapter 4. Data Analysis Overview ....................................... 21  
  - Data Analysis Window .................................................... 21  
  - Well Selectors .................................................................... 24  
  - Charts ................................................................................. 25  
  - Spreadsheets ...................................................................... 26  
  - Viewing Well Groups in Data Analysis .............................. 27  
  - Step Number Selection .................................................... 29  
  - Excluding Wells From Analysis ....................................... 29
# Table of Contents

**Chapter 5. Analyzing Melt Data** ........................................... 31
  - Processing Melt Data ......................................................... 31
  - Precision Melt Tab ......................................................... 32
  - Precision Melt Data Tab ..................................................... 39
  - Melt Curve Tab ............................................................... 43
  - Melt Curve Data Tab ......................................................... 45
  - Reports for Melt Files ....................................................... 47

**Chapter 6. Melt Study Analysis** ........................................... 51
  - Melt Study Window .......................................................... 51
  - Study Setup Tab .............................................................. 52
  - Study Analysis Tab .......................................................... 53
  - Melt Study Report Window .................................................. 53

**Index** .................................................................................. 57
1 HRM Analysis

Read this chapter for information about high resolution melt (HRM) analysis.

- Introduction to HRM analysis (below)
- Guidelines for successful HRM analysis (page 2)
- Dye compatibility (page 3)
- HRM analysis in the literature (page 3)

Introduction to HRM Analysis

Real-time PCR assays using non-specific DNA binding dyes such as SYBR Green generally include a post-PCR melt curve to confirm a single PCR product has been amplified, or to detect the possible presence of primer-dimers or other unwanted PCR products.

For melt curve analysis the temperature is gradually increased and fluorescence is monitored as a function of the temperature. As the temperature rises the fluorophore is released from the denaturing dsDNA and the fluorescence decreases with a noticeable change in slope at the melting temperature ($T_m$) of the dsDNA, the theoretical temperature at which half the DNA is double stranded and half the DNA is single stranded. The rate of change is determined by plotting the negative first regression of relative fluorescence (RFU) versus temperature ($-d(RFU)/dT$), yielding visible peaks that represents the $T_m$ of the double-stranded DNA complexes. Primer-dimers typically melt at lower temperatures due to their smaller size, enabling primer-dimers or other non-specific products to be discontinued from the amplified DNA product.

HRM analysis can be considered the next generation of the melt curve technique. HRM analysis generates DNA melt curve profiles that are both specific and sensitive enough to distinguish nucleic acid species based on small nucleic acid differences enabling mutation scanning, methylation analysis, and genotyping.

HRM analysis can be used to characterize samples based on sequence length, GC content and DNA sequence complementarity. For example, HRM analysis can be used to detect single base sequence variations such as single nucleotide polymorphisms (SNPs) or to discover unknown genetic mutations. It can also be used to quantitatively detect a small proportion of variant DNA in a background of wild-type sequence at sensitivities approaching 5%. This approach can be used, for example, to study somatically acquired mutations or changes in the methylation state of CpG islands.
**SNP Genotyping**

Representative of the smallest genetic change, the detection and genotyping of SNPs underlines the sensitivity of HRM analysis. Unknown mutations are often a single nucleotide change, but they may also comprise multiple base changes, insertions and/or deletions. In general, the more base changes in the DNA, the easier they are to detect by HRM.

SNPs have been divided into four classes as summarized in Table 3, the most difficult to genotype are the class 4 (A>T conversions).

**Table 3. SNP classes as defined by Venter et al. (2001)**

<table>
<thead>
<tr>
<th>SNP Class</th>
<th>Base Change</th>
<th>Typical T_m Melt Curve Shift</th>
<th>Rarity (in the Human Genome)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>C/T and G/A</td>
<td>Large &gt; 0.5°C</td>
<td>64%</td>
</tr>
<tr>
<td>2</td>
<td>C/A and G/T</td>
<td>Large &gt; 0.5°C</td>
<td>20%</td>
</tr>
<tr>
<td>3</td>
<td>C/G</td>
<td>Large &gt; 0.5°C</td>
<td>9%</td>
</tr>
<tr>
<td>4</td>
<td>A/T</td>
<td>Very small &lt; 0.2°C</td>
<td>7%</td>
</tr>
</tbody>
</table>

For SNP analysis, homozygous allelic variants are characterized by a temperature (x-axis) shift in a HRM melt curve, whereas heterozygotes are characterized by a change in melt curve shape. The change in curve shape is a result of destabilized heteroduplex annealing between some of the wild type and variant strands. The heterozygote melting curve is thus a composite of both heteroduplex and homoduplex components, and because it dissociates more readily it shifts to a lower temperature.

**Guidelines for Successful HRM Analysis**

The success of HRM analysis highly depends on the quality of the individual PCR product and the specific sequence under investigation. All experimental parameters must be controlled and highly reproducible from sample to sample to ensure successful HRM analysis.

**Recommended guidelines for successful HRM analysis are provided below.**

1. **Analyze small DNA amplicons**

Analyzing amplicons smaller than 150 bp is preferable, especially when sites with a known polymorphism are investigated. It is possible to detect sequence variations with longer amplicons, however, a single base variation influences the melting behavior of a 100 bp amplicon more than a 600 bp amplicon.

2. **Analyze a single pure product**

Avoid sequences that are likely to form non-specific products or primer dimers. Always run BLAST search (http://www.ncbi.nlm.nih.gov/BLAST) to check the specificity of the primers sequences to the target species and gene. In addition, bad resolution or poor grouping may occur when secondary structures in single-stranded or partially denatured DNA are present. The amplicon sequences should be entered into MFOLD (http://mfold.bioinfo.rpi.edu/cgi-bin/dna-form1.cgi) to assure that they do not form any secondary structures during PCR.

3. **Use sufficient pre-amplification template**

Analyzing real-time PCR amplification data can be extremely useful when troubleshooting HRM analyses. Samples should have a cycle threshold (C_T) less than 30 cycles. Products that amplify late due to too little starting template amount or template degradation produce variable HRM results.
4. Normalize template concentration
The amount of template added to the reaction should be consistent. Normalize the starting concentrations so that all amplification plots are within 3 C(t)s of each other, a 10-fold range.

5. Check for aberrant amplification plots
Examine amplification data carefully for abnormal amplification curve shapes. A curve with a jagged log-linear phase or one that reaches a low signal plateau compared to other reactions can indicate poor amplification or a fluorescence signal too low for analysis. Unsuccessful amplification can be caused by reaction inhibitors, too little dye, or incorrect reaction set-up. HRM analysis from such samples can cause low resolution or poor grouping.

6. Keep post-amplification sample concentrations similar
Minimizing reaction to reaction variability is critical, and using the same sample preparation procedure will minimize this variability. Since the concentration of a DNA fragment affects its melting temperature, ensure every reaction has amplified to the plateau phase. Poor reactions might not reach plateau with the same amplified quantity due to inconsistent assay set-up.

7. Ensure sample-to-sample uniformity
Samples must be of equal volume and with the same concentration of dye. DNA melting behavior is affected by salts in the reaction mix, so the concentration of buffer, Mg²⁺ and other salts should be as uniform as possible in all samples.

8. Allow sufficient data collection for pre- and post-melt regions
For easier data interpretation and results with tighter replicates, ensure enough baseline data points were collected. This can be easily accomplished by capturing HRM data points over at least a 10°C (or greater) window, centered around the observed Tₘ of the amplified product.

Dye Compatibility
Third generation intercalating dyes, such as EvaGreen, LCGreen and SYTO 9, have been used successfully for high resolution melt analysis. These dyes have low toxicity and can be used at higher concentrations in real-time PCR reactions. These dyes are used at higher concentration for greater saturation of dsDNA and less dynamic dye redistribution to non-denatured regions of the nucleic strand during melting. The high fidelity of these third generation dyes provides greater sensitivity and higher resolution melt profiles.

WARNING! SsoFast EvaGreen supermix cannot be used with bisulfite-converted DNA for methylation studies.

HRM Analysis in the Literature
Review the following references to learn more about HRM analysis.

Basics of the Technology

Advanced Techniques


Oncology (heterozygous dominant mutations & allele fractions)


Infectious Disease (haploid genomes)


HLA Matching

Genotyping for Genetic Disorders


Mutation Scanning for Genetic Disorders


References
2 Precision Melt Analysis™ Software

Read this chapter for information about installing Precision Melt Analysis software.

- Instrument compatibility (below)
- Precision Melt Analysis software components (page 5)
- Software installation (page 6)
- Hardware protection key (page 8)
- Melt calibration (page 8)

Instrument Compatibility

A CFX96™ or CFX384™ real-time PCR detection system can be used in combination with Precision Melt Analysis software to perform HRM analysis and characterize samples based on sequence length, GC content, and DNA sequence complementarity. Precision Melt Analysis software can only open data files generated from an experiment performed on a CFX96 or CFX384 real-time PCR detection system and analyzed using CFX Manager™ software. Real-time PCR data files (.pcrd) generated by CFX Manager software are converted to melt files (.melt) when Precision Melt Analysis software displays the data.

NOTE: When performing high resolution melt analysis using the CFX96 or CFX384 system, use the SYBR/FAM only scan mode with SYBR selected as the fluorophore.

TIP: For optimal high resolution melt results, use a 0.2°C temperature increment between steps and a hold time minimum of 10 seconds in the melt curve protocol.

Precision Melt Analysis Software Components

The Precision Melt Analysis software package includes the components listed below. If any items are missing or damaged, contact your local Bio-Rad office.

- Precision Melt Analysis software CD-ROM
- Two hardware protection (HASP) keys
- Instruction manual for Precision Melt Analysis software
- Precision Melt Analysis software quick guide
A melt calibration kit (catalog number 1845020) will also be shipped with the following components:

- Melt Calibration DNA standard
- Melt Calibration Primers
- SsoFast EvaGreen supermix
- Melt Calibration instructions for Precision Melt Analysis software

**Software Installation**

Precision Melt Analysis software is run on a PC computer with either the Windows XP or Windows Vista operating system. Table 4 lists the computer system requirements for Precision Melt Analysis software.

**Table 4. Computer requirements for Precision Melt Analysis software**

<table>
<thead>
<tr>
<th>System</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows XP Professional SP2 and Above or Windows Vista Home Premium and above</td>
<td>Windows XP Professional SP2 and above or Windows Vista Home Premium and above</td>
</tr>
<tr>
<td>Drive</td>
<td>CD-ROM drive</td>
<td>CD-RW drive</td>
</tr>
<tr>
<td>Hard drive</td>
<td>10 GB</td>
<td>20 GB</td>
</tr>
<tr>
<td>Processor speed</td>
<td>2.0 GHz</td>
<td>2.0 GHz</td>
</tr>
<tr>
<td>RAM</td>
<td>1 GB RAM (2 GB for Windows Vista)</td>
<td>2 GB RAM</td>
</tr>
<tr>
<td>Screen resolution</td>
<td>1024 x 768 with true-color mode</td>
<td>1280 x 1024 with true-color mode</td>
</tr>
<tr>
<td>USB</td>
<td>USB 2.0 Hi-Speed port</td>
<td>USB 2.0 Hi-Speed port</td>
</tr>
<tr>
<td>Internet browser</td>
<td>Internet Explorer</td>
<td>Internet Explorer</td>
</tr>
<tr>
<td>Software</td>
<td>Internet Explorer</td>
<td>Microsoft Office Suite</td>
</tr>
</tbody>
</table>

NOTE: Precision Melt Analysis software and CFX Manager software are compatible and can both be installed on the same computer system.

**To install Precision Melt Analysis software:**

1. The software must be installed on the computer by a user with administrative privileges. Make sure you are logged in with administrative privileges.

2. Place the Precision Melt Analysis software CD in the computer's CD drive. The Precision Melt Analysis software installation screen will appear (Figure 1).

NOTE: If the software installation screen does not appear, double-click (CD drive):\Bio-Rad Precision Melt Analysis. Open and follow instructions in the Readme.txt file to install the software manually.
3. Click **Next** on the software installation screen (Figure 1).

![Figure 1. Software installation screen.](image1)

4. To install the software, you must accept the terms in the license agreement. Click the radio button to accept the terms. Click **Next** (Figure 2).

![Figure 2. End User License Agreement.](image2)

5. Click **Next** to install the software to the specified, default destination folder (Figure 3).

![Figure 3. Installation folder designation.](image3)
6. The wizard is now ready to begin installation. Click **Install** to install the software program in the specified destination folder (Figure 4).

![Figure 4. Software installation.](image)

7. When the software installation is complete, click **Finish** to exit the installation wizard.

8. When completed, the Bio-Rad Precision Melt Analysis software icon appears on the desktop of the computer (Figure 5).

![Figure 5. Precision Melt Analysis software desktop icon.](image)

NOTE: To uninstall Precision Melt Analysis software from your computer, use the Windows **Add/Remove Programs** function. Click the Windows Start button, select Settings, select Control Panel, double-click **Add/Remove Programs**, and follow the instructions for removing the program.

### Hardware Protection Key

The supplied HASP key is required to run Precision Melt Analysis software. You must attach the HASP key to a USB port on your computer before you can run the software.

NOTE: If you lose your HASP key, please contact your local Bio-Rad office.

### Melt Calibration

Before Precision Melt Analysis software can analyze data generated on a CFX96 or CFX384 real-time PCR system, a melt calibration must be performed.

NOTE: A melt calibration is required regardless of the intercalating dye that will be used in the experiments, including SYBR™Green.

TIP: Follow the Melt Calibration Quick Guide for easy preparation of the melt calibration plate.
Preparing the Melt Calibration Plate

Bio-Rad Laboratories provides the following materials in the Melt Calibration kit (1845020) to create a melt calibration plate:

- 10016289. Melt Calibration DNA Standard
- 10016273. Melt Calibration primers
- 1725200. SsoFast™ EvaGreen® supermix

Additional Materials Required

In addition to the components provided in the melt calibration kit, the following materials are required to prepare the melt calibration plate:

- PCR-grade tubes, and nuclease-free water
- MSB-1001. Microseal® ‘B’ adhesive seals, optically clear

To calibrate a CFX384 system:

- HSP-3805. Hard-Shell® thin-wall 384-well skirted PCR plates with clear shell and white wells for use with a CFX384 system

To calibrate a CFX96 system:

Choose white wells or natural wells depending on the plate type you plan to use in your experiments

- MLL-9601. Multiplate™ low-profile 96-well unskirted PCR plates with natural wells to calibrate a CFX96 system, or
- MLL-9651. Multiplate low-profile 96-well unskirted PCR plates with white wells for use with a CFX96 system

**WARNING!** SsoFast EvaGreen supermix is stable for 12 months when stored in a constant temperature freezer at –20°C, protected from light. For convenience, it may be stored at 2–8°C for up to 6 months. Repeated freezing and thawing of the supermix is not recommended.

Preparing the melt calibration plate

1. Add the required volumes of each component to an appropriately sized tube (Table 5).

<table>
<thead>
<tr>
<th>Component</th>
<th>Volumes (ul) for CFX96 System</th>
<th>Volumes (ul) for CFX384 System</th>
</tr>
</thead>
<tbody>
<tr>
<td>SsoFast EvaGreen supermix</td>
<td>1,200</td>
<td>2,250</td>
</tr>
<tr>
<td>Melt Calibration DNA standard</td>
<td>120</td>
<td>450</td>
</tr>
<tr>
<td>Melt Calibration Primers</td>
<td>14.4</td>
<td>27</td>
</tr>
<tr>
<td>PCR-grade Water</td>
<td>1065.6</td>
<td>1,773</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>2,400</strong></td>
<td><strong>4,500</strong></td>
</tr>
</tbody>
</table>

2. Cap the tube and mix the reaction components gently by vortexing.

3. Briefly centrifuge the tube to remove air bubbles and collect contents at the bottom of the tube.

4. Add the appropriate volume of the mixture into each well of a reaction plate
   - For a CFX96 system, add 20 ul to each well of a 96-well plate.
   - For a CFX384 system, add 10 ul to each well of the 384-well plate
5. Seal the reaction plate with Microseal ‘B’ adhesive film. Centrifuge the melt calibration plate to move all the reaction components to the bottom of the well.

**Performing the Melt Calibration Experiment**

The melt calibration experiment is run on a CFX96 or CFX384 real-time PCR system using the prepared melt calibration plate.

**To run the melt calibration to generate a melt calibration data file**

1. Turn on the CFX96 or CFX384 real-time PCR system.
2. Double-click the CFX Manager software desktop icon to launch the software.
3. Select **Create a new experiment** from the list of options in the Startup Wizard. Click **OK** to launch the Experiment Setup window.
4. In the Protocol tab, select **Create New** to open the Protocol Editor.
5. Create the following protocol (Table 6).

**Table 6. Melt calibration protocol**

<table>
<thead>
<tr>
<th>Cycling Step</th>
<th>Temperature</th>
<th>Time</th>
<th># of Cycles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enzyme activation</td>
<td>98°C</td>
<td>2 min</td>
<td>1</td>
</tr>
<tr>
<td>Denaturation</td>
<td>98°C</td>
<td>5 sec</td>
<td>40</td>
</tr>
<tr>
<td>Annealing/Extension</td>
<td>55°C</td>
<td>10 sec</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>95°C</td>
<td>1 min</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>55°C</td>
<td>1 min</td>
<td>1</td>
</tr>
<tr>
<td>Melt curve</td>
<td>70–95°C (in 0.2°C inc.)</td>
<td>10 sec/step</td>
<td>1</td>
</tr>
</tbody>
</table>

6. Click **OK** to save the protocol and return to the Experiment Setup window.

Or, click the **Protocol** tab

Click **Select Existing > Sample Files > Melt Calibration Folder**, select the appropriate protocol name based on your instrument and click **Open**

- For a CFX96 system, select Melt Calibration Protocol_96
- For a CFX384 system, select Melt Calibration Protocol_384

7. Click the **Plate** tab.

8. Click **Select Existing > Sample Files > Melt Calibration folder**, select the plate name based on the instrument and click **Open**.

- For a CFX96 system, select Melt Calibration Plate_96 wells_Clear, or Melt Calibration Plate_96 wells_White
- For a CFX384 system, select Melt Calibration Plate_384 wells_White

9. Click the **Start Run** tab.

10. Select the instrument in the Start Run on Selected Blocks list by clicking the checkbox to the left of the instrument name.

11. Click **Open Lid**, then load the melt calibration plate into the instrument.

12. Click **Close Lid**.
13. Click the **Start Run** button to begin running the experiment.

14. At the prompt, save the melt calibration data file as “**Melt Calibration_today's date**”.

15. When the melt calibration run is complete, the data file is automatically displayed by CFX Manager software. Check the data file to ensure all wells display a tight amplification and a single melt peak (Figure 6).

---

![Figure 6. Melt calibration data.](image)

**Importing the Melt Calibration File**

1. Launch the Precision Melt Analysis software, by double-clicking on the Precision Melt Analysis software icon on the Desktop.

2. Click **Tools> Import Melt Calibration** from the Menu bar (Figure 7).

3. Select the melt calibration experiment data file (.pcrd extension) and click **Open**.

4. A confirmation window will appear indicating that the melt calibration was successful (Figure 8).

---

![Figure 7. Melt Calibration file import.](image)

![Figure 8. Successful melt calibration.](image)
5. Click **OK** to proceed and use the Precision Melt Analysis software.
   NOTE: When you attempt to create a Melt file for the first time in Precision Melt Analysis software, you will be prompted to import this file.
3 Introduction to Precision Melt Analysis Software

Read this chapter for information about getting started with Precision Melt Analysis software.

- Main software window (below)
- Startup Wizard (page 16)
- Analysis Options Manager (page 16)
- Software files (page 18)
- Software help tools (page 19)
- Tips and tricks (page 19)

Main Software Window

Precision Melt Analysis software processes melt files (.melt) automatically, and opens the Data Analysis window to display these data. This window shows a series of tabs that include charts, spreadsheet views of these data, and the well contents.

To start Precision Melt Analysis software, make sure the HASP key is attached to your computer and double-click the application icon on your desktop.

Alternatively, select Bio-Rad > Precision Melt Analysis from the All Programs directory on your Windows Start menu.

Get started in the main software window by using these features (Figure 9):

- **Menu bar.** Select software commands (page 14), such as creating or opening files
- **Toolbar.** Click toolbar buttons (page 15) to open software files, the Startup Wizard (page 16), or the Analysis Options Manager window (page 16)
**Startup Wizard window.** Access common software commands (page 16)

![Startup Wizard window](image)

---

**Menu Bar**

The menu bar of the Precision Melt Analysis software provides access to the functions and commands listed in Table 7.

**Table 7. Menu bar items in the main software window**

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>New Melt File</td>
<td>Create a new melt file (.melt) from a CFX Manager data file (.pcrd)</td>
</tr>
<tr>
<td></td>
<td>New Melt Study File</td>
<td>Create a new melt study file (.mlts)</td>
</tr>
<tr>
<td></td>
<td>Open Melt File</td>
<td>Open an existing melt file (.melt)</td>
</tr>
<tr>
<td></td>
<td>Open Melt Study File</td>
<td>Open an existing melt study file (.mlts)</td>
</tr>
<tr>
<td></td>
<td>Recent Melt Files</td>
<td>View a list of the ten most recently viewed melt files, and select a file to open in the Data Analysis window</td>
</tr>
<tr>
<td></td>
<td>Exit</td>
<td>Exit the software program</td>
</tr>
<tr>
<td>Tools</td>
<td>Analysis Options Manager</td>
<td>Set analysis preferences</td>
</tr>
<tr>
<td></td>
<td>Import Melt calibration</td>
<td>Import the melt calibration data file (.pcrd) generated on a CFX96 or CFX384 system to create a calibration file (.mcal)</td>
</tr>
</tbody>
</table>
Table 7. Menu bar items in the main software window (continued)

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td>Contents</td>
<td>Open the software Help to find information about running the software and instruments</td>
</tr>
<tr>
<td></td>
<td>Index</td>
<td>View the index in the software Help</td>
</tr>
<tr>
<td></td>
<td>Search</td>
<td>Search the software Help</td>
</tr>
<tr>
<td></td>
<td>About</td>
<td>Open a window to see the software version</td>
</tr>
</tbody>
</table>

**Toolbar Buttons**

Click a button in the toolbar of the main software window (Table 8) for quick access to common software commands.

**NOTE:** To show or hide the toolbar, select View > Toolbar in the menu bar.

Table 8. Toolbar buttons in the main software window

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Startup Wizard" /></td>
<td>Startup Wizard</td>
<td>Open the Startup Wizard to choose common software functions</td>
</tr>
<tr>
<td><img src="image" alt="Create a New Melt file" /></td>
<td>Create a New Melt file</td>
<td>Import a data file from a CFX96 or CFX384 system (<em>.pcrd extension) to create a new melt file (</em>.melt extension)</td>
</tr>
<tr>
<td><img src="image" alt="Open a Melt file" /></td>
<td>Open a Melt file</td>
<td>Open a browser window to locate an existing melt file (*.melt extension) and open it in the Data Analysis window</td>
</tr>
<tr>
<td><img src="image" alt="Create a New Melt Study" /></td>
<td>Create a New Melt Study</td>
<td>Open the Melt Study window to create a new melt study</td>
</tr>
<tr>
<td><img src="image" alt="Open a Melt Study" /></td>
<td>Open a Melt Study</td>
<td>Open a browser window to locate an existing melt study file (*.mlts extension) and open it in the Melt Study window</td>
</tr>
<tr>
<td><img src="image" alt="Analysis Options Manager" /></td>
<td>Analysis Options Manager</td>
<td>Open the Analysis Options Manager window</td>
</tr>
<tr>
<td><img src="image" alt="Help" /></td>
<td>Help</td>
<td>Open the software Help window to find information about running the software</td>
</tr>
</tbody>
</table>
Startup Wizard

The Startup Wizard automatically appears when Precision Melt software is first opened (Figure 10). If it is not shown, click Startup Wizard on the main software toolbar.

![Startup Wizard window](image)

Figure 10. Startup Wizard window.

Options in the Startup Wizard include the following:
- **Create a new melt file.** Create a new melt file (.melt) by importing a data file (.pcrd) generated by CFX Manager software
- **Open a melt file.** Open a melt file for analysis
- **Create a new melt study.** Create a new melt study file to analyze results from multiple melt files
- **Open a melt Study.** Open a melt study file (.mlts) for analysis
- **Open the Analysis Options Manager.** Open the Analysis Options Manager to view or modify the default analysis settings

Analysis Options Manager

Precision Melt Analysis software tracks preferences for analyzing melt files. To change settings, open the Analysis Options Manager window (Figure 11) using one of these methods:
- Click Analysis Options Manager in the main software window toolbar
• Select **Tools > Analysis Options Manager** in the main software window menu bar

![Analysis Options Manager Window](image)

Figure 11. Analysis Options Manager Window.

**Melt Analysis Settings Profiles**

Use the Analysis Options Manager to choose the settings for analyzing a melt file in the Data Analysis window. Customized analysis settings can be saved and applied to different melt files. The name of the current analysis settings profile is displayed in the **Name** pull-down menu. In Figure 11 the name is **SNP Detection**. Check **Set as default** to apply the analysis settings profile to new melt files and well groups.

**To create a new analysis settings profile:**
1. Choose the analysis settings using checkbox selections and by entering specific values in text boxes in the Analysis Options Manager window.
2. Click **Add New**.
3. Enter the name in the prompt window.
4. Click **OK**.

**To rename an analysis settings profile:**
1. Choose the name of the settings profile from the **Name** drop-down menu.
2. Click **Rename**.
3. Enter the new name in the prompt window.
4. Click **OK**.

**To delete an analysis settings profile:**
1. Choose the name of the settings profile from the **Name** drop-down menu.
2. Click **Delete**.
Analysis Options

Use the Analysis Options Manager window to choose the settings for analyzing a melt file.

- **Auto detect the melt region.** Select the checkbox to enable the software to automatically define the pre-melt and post-melt temperature ranges. To manually define the pre-melt and post-melt ranges, deselect the checkbox and enter temperature values by typing a number in the text box or using the up-down arrows.

- **Normalized view.** Select to open the melt file with the melt curve data displayed in normalized view in Precision Melt tab.

- **Temperature shifted view.** Select to open the melt file with a temperature shift applied to each normalized fluorescence curve along the temperature axis (x-axis).

- **Temperature shift bar height.** Specify the temperature shift bar height by entering a number between 0 (baseline) and 1 (top of melt region). For most applications, the default temperature shift bar height of 0.20 produces acceptable results, with the melt curves clustered into tight groups.

Cluster Detection Settings

Set the cluster detection settings to determine the stringency used to cluster the melt curves.

**MELT CURVE SHAPE SENSITIVITY**

Clustering shape sensitivity determines the stringency used to classify melt curves into different clusters. To refine clustering results, increase or decrease the sensitivity of clustering based on the shape of the melt curve. Enter a numerical value or move the slider bar to the left or to the right. Entering a lower percentage value or sliding the bar to the left reduces stringency and results in less heterozygote clusters. Entering a higher percentage value or sliding the bar to the right increases stringency and results in more heterozygote clusters.

If necessary, manually decrease sensitivity to eliminate high numbers of false positives. A high sensitivity value generally produces more groups than a low value. For most applications, the default 50% clustering shape sensitivity value produces acceptable results.

**T_m DIFFERENCE THRESHOLD**

T_m difference threshold determines the lowest amount of T_m difference between samples which the software will call as different clusters. Choose the number of degrees Celsius by entering a numerical value from 0.05 to 1.00. Lower values produce more homozygote clusters.

If necessary, manually increase the T_m difference threshold level to eliminate high numbers of false positives. For most applications, the default Tm difference threshold of 0.15 degrees produces acceptable results.
Software Files

Precision Melt Analysis software stores information about experiments in specific files (Table 9).

Table 9. Precision Melt Analysis software file types.

<table>
<thead>
<tr>
<th>File Type</th>
<th>Extension</th>
<th>How to View and Edit File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td>.pcrd</td>
<td>View and analyze in Data Analysis window</td>
</tr>
<tr>
<td>Melt</td>
<td>.melt</td>
<td>View and analyze in Data Analysis window</td>
</tr>
<tr>
<td>Calibration</td>
<td>.mcal</td>
<td>Cannot be viewed</td>
</tr>
<tr>
<td>Melt Study</td>
<td>.mlts</td>
<td>View and analyze in Melt Study window</td>
</tr>
</tbody>
</table>

Software Help Tools

The Help option of Precision Melt Analysis software provides the following tools:

- Select the Search or Index tabs in this Help site to search for more information
- Open the Glossary to look up words that are specifically used in this software. For widely used words, consult a PCR dictionary or glossary
- Press the F1 key on your keyboard to open software help about topics in many of the software windows
- Print any Help page by right-clicking on it and selecting Print

Tips and Tricks

Tips and tricks for using Precision Melt Analysis software are listed below:

- Open any Melt or Melt Study file by dragging it from a folder to an open software window
- Print or export the information shown in many windows by right-clicking a chart, spreadsheet, or well selector
- Change the size of any window by clicking and dragging the edges
- Open the Preferences window to choose default settings that activate every time the software is launched
- Add melt files to a Melt Study by dragging from a folder to an open Melt Study window
- Open multiple melt files and Melt study files at the same time
- Click the Settings or Tools menus to find advanced functions
- To view all the information loaded into one well from Plate Editor, double-click the well to open the Well Info window
- Right-click any graph or chart to change viewing and data analysis options
- Select a well group to view and analyze a subset of the wells in the plate. Select each well group by name in the Well Group pull-down menu in the toolbar
4 Data Analysis Overview

Read this chapter for information about data analysis in Precision Melt Analysis software.

- Data Analysis window (below)
- Well selectors (page 24)
- Charts (page 25)
- Spreadsheets (page 26)
- Viewing well groups in the Data Analysis Window (page 27)
- Step number selection (page 29)
- Excluding wells from analysis (page 29)

Data Analysis Window

During data analysis, changing the way the data are displayed never changes the fluorescence data that are collected from each well during the run. You cannot delete those data, but you can choose to remove them from view and analysis.

Choose one of these methods to open existing melt data files in the Data Analysis window:

- Drag a melt file (.melt extension) over the main software window and release it
- Select File > New > Melt File in the main software window to select a CFX Manager software data file (.pcrd) in the Windows browser to convert it to a melt file (.melt)
- Select File > Open > Melt File in the main software window to select a melt file in the Windows browser
- Select File > Recent Files to select from a list of the ten most recently opened melt data files

The Data Analysis window displays data in charts and spreadsheets for a specific analysis method in one of five tabs (Figure 12).
Data Analysis Overview

Figure 12. Layout for the Precision Melt tab.

Data Analysis Menu Bar

The menu bar in the Data Analysis window provides the menu items listed in Table 10.

Table 10. Menu bar items in Data Analysis window

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Save</td>
<td>Save the file</td>
</tr>
<tr>
<td></td>
<td>Save As</td>
<td>Save the file with a new name</td>
</tr>
<tr>
<td></td>
<td>Close</td>
<td>Close the Data Analysis window</td>
</tr>
<tr>
<td>Settings</td>
<td>View/Edit Plate</td>
<td>Open the Plate Editor to view and edit the plate</td>
</tr>
<tr>
<td></td>
<td>Mouse Highlighting</td>
<td>Turn on or off the simultaneous highlighting of data with the mouse pointer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TIP: If the Mouse Highlighting is turned off, then hold down the Control key to temporarily turn on the highlighting</td>
</tr>
<tr>
<td>Tools</td>
<td>Reports</td>
<td>Open a Report for the current data file</td>
</tr>
<tr>
<td></td>
<td>Replace Plate</td>
<td>Replace the current plate file in the data analysis</td>
</tr>
</tbody>
</table>
Data Analysis Toolbar

The toolbar in the Data Analysis window provides quick access to important data analysis functions (Table 11).

Table 11. Toolbar in the Data Analysis window

<table>
<thead>
<tr>
<th>Toolbar button</th>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Save" /></td>
<td>Save</td>
<td>Save the current melt file</td>
</tr>
<tr>
<td><img src="image" alt="Report" /></td>
<td>Report</td>
<td>Open the Report window for the current melt file</td>
</tr>
<tr>
<td><img src="image" alt="Analysis Options" /></td>
<td>Analysis Options</td>
<td>Open the Analysis Options window to view or modify analysis settings</td>
</tr>
<tr>
<td><img src="image" alt="View/Edit Plate" /></td>
<td>View/Edit Plate</td>
<td>Open the Plate Editor to view and edit the contents of the wells</td>
</tr>
<tr>
<td><img src="image" alt="Well Group..." /></td>
<td>Well Group...</td>
<td>Select a well group name from the pull-down menu. The default selection is All Wells</td>
</tr>
<tr>
<td><img src="image" alt="Help" /></td>
<td>Help</td>
<td>Open the software Help site for more information about data analysis</td>
</tr>
</tbody>
</table>

Data Analysis Tabs

The Data Analysis window includes five tabs (Figure 13). Each tab displays data in charts and spreadsheets for a specific analysis method with a well selector to select the data you want to show. The Data Analysis window opens with the Precision Melt tab in front.

Figure 13. Precision Melt Analysis Data Analysis tabs.

The tabs show melt curve data from one experiment (a protocol and plate file run on one instrument).

- **Precision Melt tab.** Shows the melt data in four views: Melt Curve chart, Difference Curve chart, well selector, and data spreadsheet. Use the data in this tab to set the data analysis conditions, including normalization and temperature shift
- **Precision Melt Data tab.** Shows a spreadsheet view of the data in different formats: Results, Charts, Plate View, Raw RFU, Normalized RFU, and Difference RFU
- **Melt Curve tab.** Shows a melt curve chart, melt peak chart, well selector, and spreadsheet view of the melt curve data for each well. Use the data shown in this tab to measure the melting temperature ($T_m$) of PCR products
- **Melt Curve Data tab.** Shows a spreadsheet view of the data in different formats: Melt Peaks, Plate, Amplification, RFU, and $-d(RFU)/dT$ (melt peak data) spreadsheets
• **Run Information tab.** Shows information about the experiment, including the protocol, optional notes, optional ID, and run log (Figure 14). Enter and edit the data ID for the run by typing in the ID box. View the Other section to see events, such as error messages, that might have occurred during the run.

![Figure 14. Layout of the Run Information tab in the Data Analysis window.](image)

TIP: Right-click any chart, spreadsheet, or well selector for more options.

TIP: Click View/Edit Plate to open the Plate Editor and change the contents of the wells.

NOTE: The software links the data in the panes of each data analysis tab. For example, highlighting a well by placing the mouse pointer over the well in the well selector view highlights the data in all the other panes.

### Well Selectors

Click the wells in the well selector to show or hide the data in the charts and spreadsheets throughout the different tabs of the Data Analysis window.

- To hide one well, highlight and click the individual well. To show that well, highlight and click the well again.
- To hide multiple wells, click and drag across the wells you want to select. To show those wells, click and drag across the wells again.
- Click the top left corner of the plate to hide all the wells. Click the top left corner again to show all wells.
- Click the start of a column or row to hide those wells. Click the column or row again to show the wells.

Only wells loaded with content entered in the Plate Editor can be selected in the well selector. As shown in Figure 15, the well selector displays three types of wells:

- **Selected, loaded wells (blue).** The data from these wells appear in the charts and spreadsheets in the Data Analysis window.
• **Unselected, loaded wells (light gray).** The data from unselected wells do not appear in the charts and spreadsheets in the Data Analysis window.

• **Empty wells (dark gray).** These wells were not loaded in the Plate Editor window.

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
</tr>
<tr>
<td>B</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
</tr>
<tr>
<td>C</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
</tr>
<tr>
<td>D</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
</tr>
<tr>
<td>E</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
</tr>
<tr>
<td>F</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
</tr>
<tr>
<td>G</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
</tr>
<tr>
<td>H</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
<td>Unk</td>
</tr>
</tbody>
</table>

**Figure 15. Different colored wells appear in a well selector.**

### Well Selector Right-Click Menu Items

Right-click any well selector view to select the items listed in Table 12.

**Table 12. Right-click menu items in the well selectors**

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copy the content of the well to a clipboard, including Sample Type and optional Replicate #</td>
</tr>
<tr>
<td>Copy as Image</td>
<td>Copy the well selector view as an image</td>
</tr>
<tr>
<td>Print...</td>
<td>Print the well selector view</td>
</tr>
<tr>
<td>Print Selection...</td>
<td>Print the current selection</td>
</tr>
<tr>
<td>Export to Excel...</td>
<td>Export the plate to an Excel spreadsheet</td>
</tr>
<tr>
<td>Export to Text...</td>
<td>Export the plate data as a Text file</td>
</tr>
<tr>
<td>Export to XML...</td>
<td>Export the plate data as an XML file</td>
</tr>
</tbody>
</table>

### Charts

Each chart in the Data Analysis window displays the data in a different graph and includes options for adjusting the data. To magnify an area of the chart, select an area by clicking and dragging the mouse. The software resizes the chart and centers it on the selected area.

**TIP:** Return the chart to a full view by right-clicking on the chart and selecting **Set Scale to Default** from the right-click menu.
Common Right-Click Menu Items for Charts

Right-click menu items are available on all charts. Some of the available items are present for all charts, and these items can be used to change how the data are displayed or to easily export the data from a chart (Table 13).

**Table 13. Right-click menu items for charts**

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copy the chart into the clipboard</td>
</tr>
<tr>
<td>Save Image As...</td>
<td>Save the chart image in the selected image file type. Select from these formats: PNG (default), GIF, JPG, TIF, or BMP</td>
</tr>
<tr>
<td>Page Setup...</td>
<td>Preview and select page setup for printing</td>
</tr>
<tr>
<td>Print...</td>
<td>Print the chart</td>
</tr>
<tr>
<td>Show Point Values</td>
<td>Show the point values when the mouse moves over a point on the chart.</td>
</tr>
<tr>
<td>Set Scale to Default</td>
<td>Return to default chart view after magnifying the chart</td>
</tr>
<tr>
<td>Chart Options...</td>
<td>Open the Chart Options window to change the chart, including changing the title, selecting limits for the x and y axes, showing grid lines, and showing minor ticks in the axes</td>
</tr>
</tbody>
</table>

Spreadsheets

The spreadsheets shown in Data Analysis include options for sorting and transferring the data to other software programs. Sort the columns by one of these methods:

- Click and drag a column to a new location in the selected table
- Click the column header to sort the data in ascending or descending order

To sort up to three columns of data in the Sort window, follow these steps:

1. Right-click on the spreadsheet to open the menu and select **Sort**.
2. In the Sort window, select the first column title to sort. Sort the data in Ascending or Descending order.
3. Select more than one column title by selecting the title in the pull-down menu. Select **Ascending** or **Descending** to sort the column in that order.
4. Click **OK** to sort the data, or click **Cancel** to stop sorting.

Highlight the data on the associated charts and well selector by holding the mouse pointer over a cell. If you click in the cell, you can copy the contents using **CTRL-C** and paste into another software program using **CTRL-V**.

Common Right-Click Menu Items for Spreadsheets

Right-click any spreadsheet view to select the items shown in Table 14.

**Table 14. Right-click menu items for spreadsheets**

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copy the contents of the selected wells to a clipboard and then paste the contents into a spreadsheet such as Excel</td>
</tr>
</tbody>
</table>
Viewing Well Groups in the Data Analysis Window

Wells in the plate can be grouped into subsets for independent analysis using well groups. When you create well groups in the Well Groups Manager window in the Plate Editor, group names appear in the Data Analysis window within the Well Groups list on the toolbar.

TIP: To open the Plate Editor, click View/Edit Plate in the Data Analysis window toolbar.

By default, the well group All Wells is selected when the Data Analysis Window is first opened, with the data in all wells with content shown in the charts and spreadsheets.

Figure 16 shows Group 1 selected in the Well Groups menu. Only the wells in the well group appear loaded with content in the well selector, and data only for these wells are included in the data analysis calculations.

![Figure 16. Data Analysis window with Group 1 selected.](image-url)
Well Groups Manager

Set up well groups using the Well Groups Manager to independently analyze sets of wells within the same plate in the Data Analysis window. For example, set up well groups to analyze multiple experiments that were run in one plate. You can also analyze the same wells with different analysis settings.

To open the Well Groups Manager window, open the Plate Editor and click Well Groups in the toolbar (Figure 17).

Figure 17. Well Groups Manager window.

To create well groups in the Well Group Manager, follow these instructions:

1. Click Add to create a new group. The drop-down menu shows the group name as Group 1 for the first group.

2. Select the wells that will compose the well group in the plate view. Wells in a selected group are blue and wells not included in the well group are light gray. To add more wells, click the wells you want to add. To remove wells, click the wells. To add or remove a group of wells, click and drag across the group of wells.

3. Create more well groups by repeating steps 1 and 2.

4. Review the groups by selecting the group name from the drop-down list.

5. (Optional) Change the name of the group by selecting the group name in the pull-down menu and typing a new name.

6. (Optional) Delete well groups by selecting the group name in the drop-down list, and clicking Delete.

7. Click OK to finish and close the window, or click Cancel to close the window without making changes.

8. Once you create well groups, the Data Analysis window lists those groups in the Well Group pull-down menu.
**Step Number Selection**

The CFX96 or CFX384 system can acquire fluorescence data at multiple protocol steps; the software maintains the data acquired at each step independently. Precision Melt Analysis software displays the Step Number selector below the Difference Curve chart on the Precision Melt tab whenever a protocol contains more than one melt curve data collection step. When you select a step, the software applies that selection to all the data shown in the Data Analysis window. Figure 18 shows the data collection step number is 7.

![Step Number: 7](image)

Figure 18. Step Number selection in the Data Analysis window.

**Excluding Wells From Analysis**

Use one of multiple options to exclude wells from data analysis temporarily.

**Right-click option to exclude a single well.**
1. Right-click on the well in the well selector, on a fluorescence trace in any chart, or on the well data in a spreadsheet.
2. Choose **Exclude Well B7 from Analysis** from the menu options (Figure 19).

![Figure 19. Right-click to exclude a well from analysis.](image)

3. Excluded wells appear dark gray in the well selector with the well content remaining in the well.
4. Unselect the **Exclude Well from Analysis** from the right-click menu to reinclude the well.

**Plate Editor option to exclude multiple wells.**
1. Click **View/Edit Plate** on the toolbar in the Data Analysis window.
2. Select one or more wells in the plate well selector.
3. Click **Exclude Wells in Analysis** (Figure 20) to exclude the selected wells. This checkbox is at the bottom of the Plate Editor controls on the right side of the window.

![Figure 20. Exclude Wells in Analysis checkbox.](image)

In Figure 21, multiple wells were excluded from data analysis in the Plate Editor. The excluded wells are marked with an asterisk (*) and appear grayed out in color.

![Figure 21. Excluded well (marked with *) in the Plate Editor.](image)

Alternatively, to permanently remove wells from analysis, clear the contents from wells in the Plate Editor by clicking **Clear Wells**.

**WARNING!** You will have to reenter any well content that is cleared.
5 Analyzing Melt Data

Read this chapter for information about analyzing melt data in Precision Melt Analysis software.

- Processing melt data (below)
- Precision Melt tab (page 31)
- Precision Melt Data tab (page 39)
- Melt Curve tab (page 44)
- Melt Curve Data tab (page 46)

**Processing Melt Data**

Precision Melt Analysis software plots the relative fluorescence unit (RFU) data collected during a melt curve as a function to temperature. The software automatically starts with the raw melt curve data and proceeds with the following steps:

- **Negatives Detection.** All wells with sample content type designated NTC or Negative Control in the Plate Editor are automatically considered negatives. Any well with a low starting RFU is also considered a negative. All wells designated as negative are automatically excluded from cluster analysis.

  NOTE: Override a well's automatically determined negative status by manually including or excluding wells from cluster analysis. This can be done by right-clicking on the well data in one of the charts, or through the drop-down selector for the well in the data spreadsheet.

  TIP: Multiple wells can be called at once by holding down the right mouse button and dragging over the wells to select multiple wells.

- **RFU Normalization.** All non-negative wells are normalized along the RFU axis (y-axis) such that the average data value at the start of the pre-melt range is one, and the average data value at the end of the post-melt range is zero.

- **Clustering.** Precision Melt Analysis software automatically determines a cluster assignment for each non-negative well.

- **Generate Difference Curves.** For easy visual identification of clusters, the software generates a Difference Curve chart of the data. The Difference Curve shows the difference in fluorescence between a well and the fluorescence of a reference curve. The reference curve is derived from the average fluorescence of all the curves within a selected reference cluster.
**Precision Melt Tab**

Use the data in the Precision Melt tab to set data analysis conditions, including normalization and, if required, temperature shift. The Precision Melt tab shows data in four views (Figure 22):

- **Melt Curve chart.** Shows the RFUs for each well plotted against temperature. Each trace represents data from a single fluorophore in one well.
- **Difference Curve chart.** Shows the difference RFU plotted on the y-axis against temperature on the x-axis.
- **Well selector.** Select the data you want to show.
- **Spreadsheet.** Shows a spreadsheet of the data for the selected wells.

![Figure 22. Layout for the Precision Melt tab in Data Analysis window.](image)

NOTE: If the protocol includes more than one data collection step (camera icon), select the step with the data you want to view in the **Step Number** menu below the Difference Curve chart.

**Melt Curve Chart**

The Melt Curve chart shows RFUs plotted against temperatures for each well. The Melt Curve chart contains multiple options for displaying the data.
- **Normalized view.** Select **Normalized view** at the bottom of the chart to view normalized melting curves (Figure 23). Changing the view of the data in the Melt Curve chart does not change the data clustering.

![Normalized Melt Curve](image)

**Figure 23. Normalized view option selected in Melt Curve chart.**

- **Adjusting pre-melt and post-melt regions.** Two pairs of adjustable vertical sliders correspond to the **pre-melt** region (green) and the **post-melt** region (red) as shown in (Figure 24). The colored area between the sliders indicates the melt range. The regions before and after the melting transition region are set automatically by Precision Melt Analysis software. Adjust the pre-melt and post-melt regions by moving the sliders to the left or to the right by holding down the mouse cursor over a line and dragging the line.

  NOTE: Changing the pre-melt and post-melt temperature regions changes the data clustering.

![Pre-Melt and Post-Melt regions selected in Melt Curve chart](image)

**Figure 24. Pre-Melt and Post-Melt regions selected in Melt Curve chart.**

- **Temperature shifted view.** Select **Temperature shifted view** to view temperature shifted melt curves and difference curves (Figure 25). The height of the black temperature shift bar can be changed by dragging the black horizontal line in the RFU chart up or down. The temperature shift bar height corresponds to the Y axis value at which all the melt curves will intersect. It is only displayed when **Temperature shifted**
view is selected. The default value for the temperature shift bar height is specified in the Analysis Options Manager window.

Figure 25. Temperature Shifted view option selected in Melt Curve chart.

TIP: To magnify any area of the Melt Curve chart, click and drag the mouse across an area of the chart. To return the chart to a full view, right-click and select Set Scale to Default from the menu.

Difference Curve Chart

For easy visual identification of clusters, Precision Melt Analysis software generates a difference curve for each well (Figure 26). The Difference Curve chart shows the difference in fluorescence between a well and the fluorescence of a reference curve. The reference curve is derived from the average fluorescence of all the curves within a selected reference cluster. Select the reference cluster from the Reference cluster menu under the Difference Curve chart.

Figure 26. Reference cluster selection.
Analysis Options Window

Select Analysis Options from the toolbar of the Data Analysis window. In the Analysis Options window, refine clustering results by increasing or decreasing the stringency used to classify well data into different clusters (Figure 27).

![Analysis Options](image)

Figure 27. Analysis Options manager window.

Choose the settings for analyzing melt file data in the Data Analysis window. After making changes to the settings, click OK to return to the Data Analysis window and apply those changes. Click Cancel to close the Analysis Options window without making any changes to the currently applied settings.

- **Auto detect the melt region.** Select the checkbox to enable the software to automatically define pre-melt and post-melt temperature ranges. To manually define the pre-melt and post-melt ranges, deselect the checkbox and enter temperatures values by typing a number in the text box or by using the up and down arrows.
- **Normalized view.** Select to view the melt curve data displayed in normalized view in the Melt Curve chart.
- **Temperature shifted view.** Select to apply a temperature shift to each normalized fluorescence curve along the temperature axis (x-axis).
- **Temperature shift bar height.** Specify the temperature shift bar height by entering a number between 0 (baseline) and 1 (top of melt region). For most applications, the default temperature shift bar height of 0.20 produces acceptable results, with the melt curves clustered into tight groups.

Cluster Detection Settings

Set the cluster detection settings to determine the stringency used to cluster the melt curves.
**MELT CURVE SHAPE SENSITIVITY**

Clustering shape sensitivity determines the stringency used to classify melt curves into different clusters. To refine clustering results, increase or decrease the sensitivity of clustering based on the shape of the melt curve. Enter a numerical value or move the slider bar to the left or to the right. Entering a lower percentage value or sliding the bar to the left reduces stringency and results in less heterozygote clusters. Entering a higher percentage value or sliding the bar to the right increases stringency and results in more heterozygote clusters.

If necessary, manually decrease sensitivity to eliminate high numbers of false positives. A high sensitivity value generally produces more groups than a low value. For most applications, the default 50% clustering shape sensitivity value produces acceptable results.

**Tm DIFFERENCE THRESHOLD**

Tm difference threshold determines the lowest amount of Tm difference between samples which the software will call as different clusters. Choose the number of degrees Celsius by entering a numerical value from 0.05 to 1.00. Lower values produce more homozygote clusters.

If necessary, manually increase the Tm difference threshold level to eliminate false positives. For most applications, the default Tm difference threshold of 0.15 degrees produces acceptable results.

**Analysis Settings Profiles**

Click **Load from Analysis Options Manager** to select a previously saved analysis settings profile from the Load Analysis Options window. Click **OK** to apply the analysis settings.

Click **Save to Analysis Options Manager** to save the analysis options settings currently selected in the Analysis Options Manager. Enter a name for the settings profile in the text box in the Save Analysis Options window and click **OK**.
Manual Assignment of Clusters

Right-click on the fluorescence trace of a well in the Melt Curve or Difference Curve chart to override the cluster assignment or change the cluster name (Figure 28).

Figure 28. Changing the cluster assignment for a sample.

NOTE: Multiple wells can be called at once by holding down the right mouse button and dragging over the wells.

Select from the options listed in the Selected Sample menu:

- Select from the list of cluster names to assign the sample well(s) to the cluster.
- Select <Create New Cluster> to assign the selected well to a new cluster. Enter the name of the new cluster in the Name window and click OK.
- If you previously changed the automatic call of a sample, select <Undo Manual Cluster> to change the cluster assignment back to the software assigned cluster call.
- Select <Exclude from Clusters> to exclude the selected sample(s) from cluster analysis. Excluded samples display Excluded in the Cluster column in the data spreadsheet (Figure 29). Excluded samples are not shown in the Normalized Melt Curve chart or the Difference Curve chart. They are shown in black in the non-normalized Melt Curve chart. The raw Melt Curve chart is displayed when the “Normalized View” checkbox is unchecked.
- To re-include excluded samples, select them from the raw Melt Curve chart by right-clicking on a single sample or right-click-dragging over multiple samples, and click <Include in Clusters> in the popup menu.

Figure 29. Sample excluded from clusters.
Analyzing Melt Data

Changing Cluster Parameters

Right-click on the fluorescence trace of a well in the Melt Curve or Difference Curve chart to change cluster parameters (Figure 30).

Changes made to the cluster are applied to all samples in the cluster. Select from the options listed in the Selected Cluster menu:

- Select <Set Cluster Name> to assign a name to the cluster. Enter the name of the cluster in the Rename window text box and click OK
- Select <Set Cluster Color> to change the color of the fluorescence traces for the wells assigned to the selected cluster. Choose the new color from the color options in the Color window and click OK
- Select <Set as the Reference Cluster> to use the selected cluster as the Difference Curve reference cluster

Precision Melt Tab Spreadsheet

Table 15 lists the data shown in the spreadsheet at the bottom right of the Precision Melt tab.

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well</td>
<td>Well position in the plate</td>
</tr>
<tr>
<td>Content</td>
<td>A combination of the Sample Type and Replicate # loaded in the well in the Plate Editor</td>
</tr>
<tr>
<td>Sample</td>
<td>Sample name loaded in the well in the Plate Editor</td>
</tr>
<tr>
<td>Cluster</td>
<td>Name of the cluster assignment for the well</td>
</tr>
<tr>
<td>Confidence</td>
<td>Indication of the relative probability the sample has of being in a cluster</td>
</tr>
</tbody>
</table>

TIP: To make changes to the Content and Sample, open the Plate Editor by clicking View/Edit Plate.
Confidence Level

Precision Melt Analysis software determines a probability distribution for each cluster based on the standard deviation of the melt curves within the same cluster. Each sample is mapped onto each cluster’s probability distribution, based on that sample’s similarity to the mean melt curve across each sample in the cluster. The confidence value is an indication of the relative probability the sample has of being in a cluster.

Manually Changing Clusters

In the Precision Melt tab spreadsheet, select options from the pull-down menu in a cell in the Cluster column to override the cluster assignment or change cluster properties (Figure 31).

![Figure 31. Changing clusters in the spreadsheet.](image)

Options to change the cluster assignment include the following:

- Select from the list of cluster names to assign the sample well(s) to a new cluster
- Select `<Create New Cluster>` to assign the selected well to a new cluster. Enter the name of the new cluster in the Name window and click `OK`
- If you previously changed the automatic call of a sample, select `<Undo Manual Cluster>` to change the cluster assignment back to the software called cluster
- Select `<Exclude from Clusters>` to remove the well from the assigned cluster. Wells excluded from clusters display `Excluded` in the Cluster column in the data spreadsheet. Select `<Include in Clusters>` to re-include the sample in the cluster analysis

Changes made to the cluster are applied to all samples in the cluster. Options to change the cluster parameters include the following:

- Select `<Set Cluster Name>` to assign a name to the cluster. Enter the name of the cluster in the Rename window text box and click `OK`
- Select `<Set Cluster Color>` to change the color of the fluorescence traces for the wells assigned to the selected cluster. Choose the new color from the color options in the Color window and click `OK`
- Select `<Set as the Reference Cluster>` to use the selected cluster as the Difference Curve reference cluster.

NOTE: The above mentioned changes can also be done on the chart.
**Precision Melt Data Tab**

The Precision Melt Data tab shows spreadsheets that describe the melt data collected in each well. Select one of the six options to show the data in different formats.

- **Results.** Displays a spreadsheet view of the data
- **Charts.** Displays multiple data charts in a single sheet
- **Plate view.** Displays a view of the data in each well as a plate map
- **Raw RFU.** Displays the RFU value in each well for each temperature
- **Normalized RFU.** Displays the normalized RFU value in each well for each temperature
- **Difference RFU.** Displays the difference RFU value in each well for each temperature

TIP: Right-click any spreadsheet for options. Sort the data in any spreadsheet by right-clicking and choosing the Sort option. Click **View/Edit Plate** to open the Plate Editor, and change the contents of any wells in the plate.

**Results Spreadsheet**

Select a **Results** spreadsheet (Figure 32) to see data for each well in the plate.

![Results Spreadsheet](image)

**Figure 32. Precision Melt Data tab with Results spreadsheet selected.**

The Results spreadsheet includes the information listed in Table 16.

**Table 16. Results spreadsheet contents**

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well</td>
<td>Well position in the plate</td>
</tr>
<tr>
<td>Content</td>
<td>A combination of the Sample Type and Replicate # loaded in the Plate Editor</td>
</tr>
<tr>
<td>Sample</td>
<td>Sample name loaded in the well in the Plate Editor</td>
</tr>
<tr>
<td>Cluster</td>
<td>Name of the cluster assignment for the well</td>
</tr>
<tr>
<td>Percent Confidence</td>
<td>Confidence percent value as an integrity check for auto-called results</td>
</tr>
<tr>
<td>Call Type</td>
<td>Automatic or Manual. Automatic means the software assigned the cluster call for the well. Manual means the user assigned the cluster call for the well</td>
</tr>
</tbody>
</table>
Charts View Spreadsheet

Select the Charts spreadsheet (Figure 33) to view multiple data charts for all wells.

![Charts spreadsheet](image)

**Figure 33. Precision Melt Data tab with Charts spreadsheet selected.**

Select a fluorescence curve in a chart to display the information listed in Table 17.

**Table 17. Content displayed for a highlighted fluorescence curve.**

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well</td>
<td>Well position in the plate</td>
</tr>
<tr>
<td>Content</td>
<td>A combination of the Sample Type and Replicate # loaded in the well in the Plate Editor</td>
</tr>
<tr>
<td>Sample</td>
<td>Sample name loaded in the well in the Plate Editor</td>
</tr>
<tr>
<td>Cluster</td>
<td>Cluster name</td>
</tr>
</tbody>
</table>
Analyzing Melt Data

**Plate View Spreadsheet**

Select **Plate View** spreadsheet to see a plate map of the data. Figure 34 shows the Plate view spreadsheet as plate map.

![Figure 34. Plate spreadsheet in Precision Melt Data tab.](image)

The Plate View spreadsheet includes the type of information shown in Table 18, including the selected fluorophore in the plate map.

**Table 18. Plate spreadsheet contents**

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content</td>
<td>A combination of the Sample Type and Replicate # loaded in the well in the Plate Editor</td>
</tr>
<tr>
<td>Sample</td>
<td>Sample name loaded in the well in the Plate Editor</td>
</tr>
<tr>
<td>Cluster</td>
<td>Cluster name</td>
</tr>
<tr>
<td>Color</td>
<td>Cluster color</td>
</tr>
</tbody>
</table>

Select the **Raw RFU** spreadsheet to view raw fluorescence readings for each well acquired at each temperature step of the melt curve protocol. The well number appears at the top of each column, and temperature appears to the left of each row (Figure 35).

![Figure 35. Raw RFU spreadsheet in the Precision Melt Data tab.](image)
The raw RFU spreadsheet includes the type of information shown in Table 19.

**Table 19. Raw RFU spreadsheet contents**

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well number</td>
<td>Well data, listed by position in the plate for all the loaded wells</td>
</tr>
<tr>
<td>Temperature</td>
<td>Temperature data listed in ascending order for all the loaded wells</td>
</tr>
</tbody>
</table>

**Normalized RFU Spreadsheet**

Select the **Normalized RFU** spreadsheet to view normalized fluorescence readings for each well. Negative wells do not appear in this spreadsheet because they are excluded from normalized processing (Figure 36).

![Normalized RFU Spreadsheet](image)

**Figure 36. Precision Melt data tab showing the Normalized RFU data**

The Normalized RFU spreadsheet includes the type of information shown in Table 20.

**Table 20. Normalized RFU spreadsheet contents**

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well number</td>
<td>Well data, listed by position in the plate for all the loaded wells</td>
</tr>
<tr>
<td>Temperature</td>
<td>Temperature data listed in ascending order for all the loaded wells</td>
</tr>
</tbody>
</table>
**Difference RFU Spreadsheet**

Select the Difference RFU spreadsheet to view the difference fluorescence readings for each well. Negative wells do not appear in this spreadsheet because they are excluded from difference processing (Figure 37).

*Figure 37. Precision Melt data tab showing the Difference RFU data.*

![Difference RFU spreadsheet](image)

The Difference RFU spreadsheet includes the type of information shown in Table 21.

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well number</td>
<td>Well data, listed by position in the plate for all the loaded wells</td>
</tr>
<tr>
<td>Temperature</td>
<td>Temperature data listed in ascending order for all the loaded wells</td>
</tr>
</tbody>
</table>

**Melt Curve Tab**

In the Melt Curve tab, Precision Melt Analysis software plots the RFU data collected during a melt curve as a function of temperature. To analyze melt peak data, a beginning and ending temperature is assigned to each peak. The floor of the peak area is specified by the position of the melt threshold bar. A valid peak must have a minimum height relative to the distance between a threshold and the height of the highest peak.

Open the Melt Curve tab (Figure 38) to determine the melting temperature ($T_m$) of amplified PCR products. This tab shows the melt curve data in these four views:

- **Melt Curve.** View the real-time data for each fluorophore as RFUs per temperature for each well
- **Melt Peak.** View the negative regression of the RFU data per temperature for each well
- **Well Selector.** Select wells to show or hide the data
- **Peak spreadsheet.** View a spreadsheet of the data collected in the selected well

**NOTE:** This spreadsheet only shows as many as two peaks for each trace. To see more peaks, click the Melt Curve Data tab (page 46).
Adjusting Melt Curve Data

Adjust the melt curve data by any of these methods:

- Click and drag the threshold bars in the Melt Peak chart to include or exclude peaks in data analysis.
- To change the color of the traces in Melt Curve and Melt Peak charts, right-click on a chart and select Trace Styles from the menu. In the Trace Styles window, use the tools to adjust appearance of traces, and preview the changes in the well selector at the bottom of the window.
- Select a number in the Step Number selector under the Melt Peak chart to view the melt curve data at another step in the protocol.
- Select wells in the well selector to focus on subsets of the data.
- Select a well group to view and analyze a subset of the wells in the plate. Select each well group by name in the Well Group pull-down menu in the toolbar.

Melt Curve Tab Spreadsheet

Table 22 shows the type of information in the spreadsheet at the bottom right side of the Melt Curve tab.

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well</td>
<td>Well position in the plate</td>
</tr>
<tr>
<td>Fluor</td>
<td>Fluorophore detected</td>
</tr>
<tr>
<td>Content</td>
<td>A combination of Sample Type and Replicate #</td>
</tr>
<tr>
<td>Sample</td>
<td>Sample Name loaded in the Plate Editor</td>
</tr>
<tr>
<td>Melt Temp</td>
<td>The temperature of the melt peak for each well. Only the two highest peaks are displayed in this spreadsheet.</td>
</tr>
</tbody>
</table>
Melt Curve Data Tab

The Melt Curve Data tab shows the data from the Melt Curve tab in multiple spreadsheets that include all the melt peaks for each trace. Select one of these four options to show the melt curve data in different spreadsheets:

- **Melt Peaks.** List all the data, including all the melt peaks, for each trace
- **Plate.** List a view of the data and contents of each well in the plate
- **RFU.** List the RFU quantities at each temperature for each well
- **-d(RFU)/dT.** List the negative rate of change in RFU as the temperature (T) changes. This is a first regression plot for each well in the plate

Melt Peaks Spreadsheet

Select the **Melt Peaks** spreadsheet (Figure 39) to view melt curve data.

![Melt Peaks spreadsheet](image)

Figure 39. Melt Peaks spreadsheet in Melt Curve Data tab.

The Melt Peaks spreadsheet (Figure 39) includes the type of information shown in Table 23.

Table 23. Melt Peaks spreadsheet content

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well</td>
<td>Well position in the plate</td>
</tr>
<tr>
<td>Fluor</td>
<td>Fluorophore detected</td>
</tr>
<tr>
<td>Content</td>
<td>Sample Type listed in the Plate Editor window</td>
</tr>
<tr>
<td>Target</td>
<td>Amplification target (gene)</td>
</tr>
<tr>
<td>Sample</td>
<td>Sample Name listed in the Plate Editor window</td>
</tr>
<tr>
<td>Melt Temperature</td>
<td>The melting temperature of each product, listed as one peak (highest) per row in the spreadsheet</td>
</tr>
<tr>
<td>Peak Height</td>
<td>Height of the peak</td>
</tr>
<tr>
<td>Begin Temperature</td>
<td>Temperature at the beginning of the peak</td>
</tr>
<tr>
<td>End Temperature</td>
<td>Temperature at the end of the peak</td>
</tr>
</tbody>
</table>
**Plate Spreadsheet**

Select the **Plate** spreadsheet (Figure 40) to view melt curve data in a plate format.

![Figure 40. Plate spreadsheet in Melt Curve Data tab.](image)

NOTE: To adjust the peak that the software calls, adjust the threshold line in the Melt Peak chart on the Melt Curve tab.

The Plate spreadsheet includes the types of information shown in Table 24.

**Table 24. Plate spreadsheet contents**

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content</td>
<td>A combination of Sample Type (required) and Replicate # (optional)</td>
</tr>
<tr>
<td>Sample</td>
<td>Sample description</td>
</tr>
<tr>
<td>Peak 1</td>
<td>First melt peak (highest)</td>
</tr>
<tr>
<td>Peak 2</td>
<td>Second (lower) melt peak</td>
</tr>
</tbody>
</table>

**RFU Spreadsheet**

Select the **RFU** spreadsheet to view the fluorescence for each well at each cycle acquired during the melt curve (Figure 41).

![Figure 41. RFU spreadsheet in Melt Curve Data tab.](image)
Table 25 lists the type of information shown in the RFU spreadsheet.

**Table 25. RFU spreadsheet content**

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well number (A1, A2, A3, A4, A5...)</td>
<td>Well position in the plate for the loaded wells</td>
</tr>
<tr>
<td>Temperature</td>
<td>Melting temperature of the amplified target. Plotted as one well per row, and multiple wells for multiple products in the same well</td>
</tr>
</tbody>
</table>

**-d(RFU)/dT Spreadsheet**

Select the -d(RFU)/dT spreadsheet to view the type of data shown in Figure 42.

![Figure 42](image)

**Reports for Melt Files**

The Report window (Figure 43) shows information about the current melt file in the Data Analysis window. To create a report, select **Tools > Reports**, or click **Reports** on the toolbar in the Data Analysis window.

The Report window shows four sections:

- **Menu and toolbar.** Select options to format, save, and print the report or template
- **Options list (top, left side of window).** Select data options and run settings to show in the report
- **Options pane (bottom, left side of window).** Enter information about a selected option
• **Preview (right side of window).** View a preview of the current report

![Image of Report window](image)

**Figure 43. Example of a Report window for a melt file.**

TIP: The layout of the report can define the type of information that appears in any report if you save the report as a template. Select Template > Save or Save As to save the layout of the current report as a template.

### Creating a Data Analysis Report

To create a report in the Data Analysis window, follow these steps:

1. Make final adjustments to the well contents, selected wells, charts, and spreadsheets in the Data Analysis window before creating the report.

2. Click **Report** in the Data Analysis toolbar to open the Report window.

3. Change the options you want to include in the report. The report opens with default options selected. Click the checkboxes in the report options list to change whole categories or individual options within a category.

   NOTE: The data that appear in the report are dependent on the current selections within the tabs of the Data Analysis window.

4. Click **Update Report** to update the Report Preview with any changes.

5. Print or save the report. Click **Print** in the toolbar to print the current report.

6. Select **File > Save** to save the report as a PDF (Adobe Acrobat Reader file), MHT (Microsoft document), or MHTML (Microsoft document) formatted file and select a location to store the file. Select **File > Save As** to save the report with a new name or in a new location.
Analyzing Melt Data

7. (Optional) Create a report template with the information you want. To save the current report settings in a template, select Template > Save or Save As. Then load the report template the next time you want to make a new report.

Report Options List
A report can include any of the options in each category described in Table 26. Use checkbox selection in the Report Options list to determine the information that appears in the report.

Table 26. Data analysis report categories in the options list

<table>
<thead>
<tr>
<th>Category</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>Report Information</td>
<td>Experiment date, user name, data file name, data file path, and selected well group</td>
</tr>
<tr>
<td></td>
<td>Notes</td>
<td>Notes about the data report</td>
</tr>
<tr>
<td>Experiment Setup</td>
<td>Run Information</td>
<td>Includes the experiment date, user, data file name, data file path, and the selected well group</td>
</tr>
<tr>
<td></td>
<td>Protocol</td>
<td>Text view of the protocol steps and options</td>
</tr>
<tr>
<td></td>
<td>Plate Display</td>
<td>Show a plate view of the information in each well of the plate</td>
</tr>
<tr>
<td>Melt Curve</td>
<td>Analysis Settings</td>
<td>Includes the melt step number and threshold bar setting</td>
</tr>
<tr>
<td></td>
<td>Melt Curve Chart</td>
<td>Copy of the melt curve chart</td>
</tr>
<tr>
<td></td>
<td>Melt Peak Chart</td>
<td>Copy of the melt peak chart</td>
</tr>
<tr>
<td></td>
<td>Data</td>
<td>Spreadsheet listing the data in each well</td>
</tr>
</tbody>
</table>

Report Options Pane
The information displayed in the Report Options pane located in the bottom left of the Report window changes depending on the highlighted option in the Report Options list. In this pane, enter information relevant to the selected option, choose a subset of information to display in the report, or choose settings for the selected option. Click Update Report to update the report in the report preview pane.
6 Melt Study Analysis

Read this chapter for information about performing melt study analysis in Precision Melt Analysis software.

- Melt Study window (below)
- Study Setup tab (page 52)
- Study Analysis tab (page 53)
- Melt Study report window (page 53)

Melt Study Window

Precision Melt Analysis software can compare melt curve data from different runs of the same instrument using a single melt study. Create a Melt Study by adding data from one or more melt files (.melt extension) to the Melt Study window. Precision Melt Analysis software groups the data into a single melt study file (.mlts extension).

NOTE: The maximum number of samples that can be analyzed in a melt study is limited by the size of the computer's RAM and virtual memory.

The Melt Study window includes two tabs. Figure 44 shows the Melt Study window with the Study Setup and Study Analysis tabs.

- Study Setup tab. Click this tab to manage the experiments in the melt study file
  NOTE: Adding or removing melt files in a Melt Study does not change the original data in that file.
- Study Analysis tab. Click this tab to view the data for the combined experiments
Study Setup Tab

The Study Setup tab (Figure 44) shows a list of all the experiments in the Melt Study.

- **Adding experiments.** Click **Add Melt Files** to select a file from a browser window. To quickly add experiments to a Melt Study, drag the melt files (.melt extension) to the Melt Study window.
  
  NOTE: When adding a melt file with multiple well groups, select the well group(s) to add to the study in the setup tab.

- **Removing experiments.** Select one or more files in the list and click **Remove Selected Files**.

- **Adding notes.** Type in the **Notes** box to add comments about the files and analysis in the Melt Study.

The Study Setup tab lists the data files in the Melt Study window, as described in Table 27.

### Table 27. Study Setup tab in Melt Study window

<table>
<thead>
<tr>
<th>Column Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Name</td>
<td>Name of the melt file (.melt extension)</td>
</tr>
<tr>
<td>File Folder</td>
<td>Directory that stores the melt file for each experiment in the Melt Study window</td>
</tr>
<tr>
<td>Date Created</td>
<td>Date the run data were collected</td>
</tr>
<tr>
<td>Well Group Name</td>
<td>Name of the well group selected when the file was added to the Melt Study window</td>
</tr>
<tr>
<td>Step</td>
<td>Protocol step that includes the plate read to collect data</td>
</tr>
<tr>
<td>Samples</td>
<td>Number of samples</td>
</tr>
</tbody>
</table>
Study Analysis Tab

The Study Analysis tab shows the data from all experiments that are added to the Melt Study. The Study Analysis tab includes the same features as the Precision Melt Analysis tab. For example, highlighting a sample in the Melt Study chart highlights the corresponding cell in the spreadsheet below the chart (Figure 45).

Figure 45. Study Analysis tab in Melt Study window.

MELT STUDY DATA SPREADSHEET

Table 28 describes the information shown in the Melt Study spreadsheet.

Table 28. Information in the spreadsheet on the Study Analysis tab

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dataset</td>
<td>Melt data from one fluorophore in one melt file</td>
</tr>
<tr>
<td>Well</td>
<td>Well position in the plate</td>
</tr>
<tr>
<td>Content</td>
<td>A combination of Sample Type (required) and Replicate Number (optional) loaded in the Plate Editor</td>
</tr>
<tr>
<td>Sample</td>
<td>Sample Name loaded in the Plate Editor wells</td>
</tr>
<tr>
<td>Cluster</td>
<td>Cluster Name</td>
</tr>
<tr>
<td>Percent Confidence</td>
<td>Indication of the relative probability the sample has of being in a cluster</td>
</tr>
<tr>
<td>Call Type</td>
<td>Auto or manual call of the cluster</td>
</tr>
</tbody>
</table>

Melt Study Report Window

Click Report in the Study Analysis toolbar to open the Report window. Select information about the Melt Study to view in the report (Figure 46).
Creating a Melt Study Report

To create a report, follow these steps:

1. Click **Report** in the Study Analysis toolbar to open the Report window.

2. Change the options you want to include in the report. The report opens with default options selected. Click the checkboxes in the report options list to change whole categories or individual options within a category.
   
   **NOTE:** The data that appear in the report are dependent on the current selections within the tabs of the Data Analysis window.

3. Click **Update Report** to update the Report Preview with any changes.

4. Print or save the report. Click **Print** in the toolbar to print the current report.

5. Select **File > Save** to save the report as a PDF (Adobe Acrobat Reader file), MHT (Microsoft document), or MHTML (Microsoft document) formatted file and select a location to store the file. Select **File > Save As** to save the report with a new name or in a new location.

6. (Optional) Create a report template with the information you want. To save the current report settings in a template, select **Template > Save** or **Save As**. Then load the report template the next time you want to make a new report.
Report Options List

A Melt Study report can include the options in each category described in Table 29. Use checkbox selection in the Report Options list to determine the information that appears in the report.

Table 29. Melt Study report categories in the options list

<table>
<thead>
<tr>
<th>Category</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>Title, subtitle and logo for the report</td>
<td></td>
</tr>
<tr>
<td>Report Information</td>
<td>Experiment date, user name, data file name, data file path, and selected well group</td>
<td></td>
</tr>
<tr>
<td>Notes</td>
<td>Notes about the data report</td>
<td></td>
</tr>
<tr>
<td>File List</td>
<td>File name, file path, data created, well group name, and step number</td>
<td></td>
</tr>
<tr>
<td>Analysis Settings</td>
<td>Includes the pre- and post-melt window, normalized view, zoomed to melt region, temperature shifted view, temperature shifted bar height, clustering shape sensitivity, and threshold bar setting</td>
<td></td>
</tr>
<tr>
<td>Melt Curve Chart</td>
<td>Copy of the melt curve chart</td>
<td></td>
</tr>
<tr>
<td>Difference Curve Chart</td>
<td>Copy of the difference curve chart</td>
<td></td>
</tr>
<tr>
<td>Data</td>
<td>Spreadsheet listing the data in each well</td>
<td></td>
</tr>
</tbody>
</table>

Report Options Pane

The information displayed in the Report Options pane located in the bottom left of the Report window changes depending on the highlighted option in the Report Options list. In this pane, enter information relevant to the selected option, choose a subset of information to display in the report, or choose settings for the selected option. Click Update Report to update the report in the report preview pane.
Index

A
Adjusting
   Data analysis charts, 25
   Melt Curve Data, 44

B
Bio-Rad Laboratories
   Resources, ii

C
CFX Manager
   Files, 18
Chart
   Data analysis, 25
Clearing wells in Plate Editor, 30
Creating
   Data report, 48, 54

D
-d(RFU)/dT
   Spreadsheet, 47
Data
   Files, 18
Data analysis
   About, 21
   Adjusting, 21
   Charts, adjusting, 25
   Clearing wells, 30
   Melt Curve, 43
   Menu bar, 22
   Plate content, 21
   Toolbar, 23
   Well contents, 21
   Well selector, 24
Data file
   Report, 47
Data report
   Creating, 48, 54
   Detected Instruments, 14

E
Exclude well using right click option, 29

F
Files
   Data, 18
   Gene Study, 18
   Plate, 18
   Protocol, 18
   Software, 18

G
Gene Study
   Files, 18
   Report, 53
   Study Analysis tab, 52
   Study Setup tab, 52
Glossary
   Software, 19
L
Layout
  Quantitation tab, 26, 32

M
Main software window, 13
Melt Curve
  Adjusting data, 44
  Data analysis, 43
  Opening tab, 43
  RFU data, 43
  Spreadsheet, 44
Melt Curve Data, 46
  Amplification Data (RFU), 46
  Plate, 46
  Tab, 45
Melt Peaks
  Spreadsheet, 45
Menu bar
  Data analysis, 22
  Main software, 13, 14

O
Opening
  Melt Curve tab, 43

P
Plate
  Files, 18
  Melt Curve Data, 46
  Spreadsheet, 46
Plate Editor
  Clearing wells, 30
Protocol
  Files, 18

Q
Quantitation
  Tab layout, 26, 32

R
Report
  Data file, 47

Gene Study, 53
RFU
  Melt Curve tab, 43

S
Safety
  Warnings, ii
Software
  Glossary, 19
  Main window, 13
  Tips and tricks, 19
Spreadsheet
  Amplification Data for Melt Curve, 46
  -d(RFU)/dT for Melt Curve, 47
  Melt Curve, 44
  Melt Peaks, 45
  Plate in Melt Curve Data, 46
  RFU for Melt Curve, 46
Startup Wizard, 13, 16
Study Analysis tab, 52
Study Setup tab, 52
Support
  Bio-Rad representatives, ii
  Technical, ii
  Technical Notes, ii

T
Tab
  Melt Curve Data, 45
  Quantitation, 22
  Study Analysis in Gene Study, 52
  Study Setup in Gene Study, 52
Technical
  Notes, ii
  Specialists, ii
Toolbar
  Data analysis, 23
  Main software, 15
  Main window, 13

W
Warning
  List in manual, ii
Well selector
  Data analysis, 24
Writing conventions, ii